
Work Stage
The @loha work stage is the first screen that you see when you start @loha.    

Use the @loha work stage to create animations, using ready-made greetings, clipart characters, backdrops, music and path effects.

Play bar

At the bottom of the Work stage is the @loha Play bar. The Play bar displays the buttons used for playing and viewing animations 
on the work stage.    

To open/close Play bar: Click on  to open and close the bar.
Stop button: Press to stop an animation.

Play button: Press to view an animation.

Forward button: Press to advance the animation frame by frame. 

Backward button: Press to reverse the animation to the first frame.    

Display counter:    Displays a frame number as you press Forward/Backward buttons.    

Effects indicator: The three graphical indicator, shows if the objects have sound, music or path effects assigned to them.    Simply 
select the object and see the light indication.



New
Create a new animation.    Displays a dialog box with a Send Player Notification message asking you if you wish to save the 
animation before clearing the work stage.



Open
 Displays the @loha directory from which you can select a file to load.



Save
Saves the current animation using the File Save As dialog box.    Enter a name in the filename bar if the animation has been newly 
created, or use the displayed name.



Save As
Saves the current animation as an ..exe file using the File Save As dialog box.    Enter a name in the filename bar if the animation 
has been newly-created, or use the displayed name.



Import
Allows you to import graphics, music or sound into @loha.    Displays a sub-menu from which you can choose the appropriate 
option.    You can import graphic files (pictures) with formats such as .bmp, .tif, .jpg or .pcx.    For music files, use files with the .midi
format, and for sound files, use the .wav format.



Picture
a submenu of Import, Picture takes you to the Open dialog box for picture files (.bmp, .tif, .jpg).



Music
a submenu of Import, Music takes you to the Open dialog box for music files (.mid)



Sound
a submenu of Import, Sound takes you to the Open dialog box for sound files (..wav).



Send
Allows you to send your creations via electronic mail.    Displays the Confirm dialog box with a message: "Do you wish to attach a 
player with the animation?"    When sending an e-mail, it is very important to attach a @play.exe (animation player).    This helps the 
recipient view your @loha file.



Print
Allows you to print a hard copy of your creations.



Printer setup
Allows you to select a printer from a list of printers for use as the default printer. 



Exit
Exits @loha.



Undo
Reverses the last action that you did on the @loha work stage.    You should note that the name of the Undo command changes 
depending on what you are doing.    By default the command is Undo.    If, for example, you moved a character by mistake and 
wanted to undo what you did, when you display the Edit drop-down menu, you will see that the command displays as 'Undo 
character move'.



Cut 
Cuts the selected object from the @loha stage area and copies it to the clipboard, where it is stored temporarily until you paste it 
somewhere else on the @loha stage area.



Copy
Copies the selected object from the @loha stage area and places it in the clipboard.



Paste
Pastes the most recent copy of an object from the clipboard onto the @loha stage area.



Arrange all
Resizes all open windows on the @loha work stage, making it easier for you to see them.



Contents
 Displays content-specific information on the help topics that you can get in @loha.



About @loha
Displays copyright information and the version number of the @loha application.



Upgrade Today!

Get all the features and power of the complete @loha!    A collection of over 650 different characters, sounds, music, effects, 
backgrounds & borders for only $49.94.    Import photos, logs, bitmaps and clipart into your @loha and completely personalize it for 
any occasion.

Order by Phone, fax or e-mail!    All we need is your name, address and method of payment. 

Tel: 1-800-793-6320

Fax: (416) 369-9037

e-mail: order@mediasyn.com



Selection tool
Allows you to select anything on the @loha work stage. 

To select single object or text:

Click the left mouse button on the object.

To select multiple object & text:

Click on the left mouse button and drag to block all the objects to be selected.    An alternative method is to hold the Shift key plus 
clicking on all the objects to be selected.



Text tool
Allows you to create one line of text from TrueType fonts.      Click on the work area, the Edit Text dialog box displays.    Select the 
font, style and size from the menu bar. Type the text.



Paragraph tool
Allows you to create a block of text that appears in a paragraph format.    Click on the work area, the Edit Text dialog box displays.    
Select the font, style and size from the menu bar. Type the text.



Square/Rectangle tool
Allows you to draw a square or rectangle by clicking on the left mouse button and dragging to create the square or rectangle.    
Release mouse button when finished.



Ellipse/Circle tool
Allows you to draw an ellipse or circle by clicking on the left mouse button and dragging the mouse to create the shape.    Release 
mouse button when you have finished drawing.



Freehand tool
Allows you to create freehand shapes by clicking on the left mouse button to form the points for the shape.    When you have 
finished the last point, simply double click and @loha will close the shape for you and finish it automatically.



Line tool
Allows you to draw straight lines by clicking on the left mouse button from point A to point B.



Fill Bucket
Allows you to add color to or to change the color of text, backgrounds and shapes. 



Rotate
Allows you to rotate text, line and freehand shapes on the work stage.    Click on the text, line or freehand shape to start the rotation. 



Fill Color
Allows you to customize the color of    background, shapes, fonts and lines.    Displays the Color Palette.    Select a color or create a 
custom color.    



Outline Color
Allows you to change the color of lines that you create on the @loha work stage. Displays the Color Palette.    Select a color or 
create a custom color.    



Line Width
Allows you to change the line width of lines or outlines of shapes that you create using the drawing tools from the Tool Palette.    
Displays a drop-down window from which you can select a line width.    You must define line width before you draw the shape.



Gallery
The @loha gallery displays the clip-toon characters, background, motion effects, sound and music snippets that you can use for 
your creations.    Click on each tab to display its contents.

Character:    Contains hundreds of characters for use in your creations.

Background:    Contains pre-built backgrounds that you can drag and drop onto the @loha work stage.

Effects:    Contains animation effects and motion that you can drag and drop onto your characters and text.

Sound:    Contains sound and music that you can drag and drop onto the @loha work stage.

Border:    Contains border designs that frame your creations.



Edit Stage
Selecting this will bring up the Stage Properties dialog box.    In this box, you can set the background colors & gradients as wells as 
playback speed.



Delete
Allows you to delete graphics, text or characters from the work stage.



Layer
Allows you to layer graphics, text or characters on the work stage.    Displays layer commands such as:



Bring to Front
Moves the selected graphic or text in front of any other graphics.



Forward One Layer
Moves the selected graphic or text forward one layer



Back One Layer
Moves the selected graphic or text back one layer



Send to Back
Moves selected graphic or text behind all other graphics.



Mirror Left to Right
 Allows you to flip your characters from left to right to create a mirror image.



Flip Top to Bottom
 Allows you to flip characters upside down.



Remove Effect
Allows you delete the most recent effect you dragged and dropped on the work stage.



Remove Music
Allows you to remove the most recent sound effect you dragged and dropped on the work stage.



Edit Text dialog box
The Edit Text dialog box displays when you click on the Paragraph or Text tool in the Tool Palette or double click on the Text in 
the work area.      Use the box to add personalized messages to your animations.    

Font style: Use the drop down menu to select the font type.

Font size: Use the drop down menu or type your own to define the font size.

Text format: Select to bold, italicize, or underline the text

Paragraph format: Select to left justify, center or right justify the paragraph.

Text color: Click to select the color of the text.

Apply path to individual characters: After selecting a Path Effect for the text, you can choose to apply the path to every single 
one of the letters in the text.    The animated text will have the letters following one another in a row.



Edit Border
Allows you to edit or choose the style of your border.    Select borders that entirely frame the work stage, frame just the left and right 
sides, frame the top and bottom sides, or frame just the four corners.



Stage Properties 
The Stage Properties Dialog Box appears when you right click on the @loha work stage. 

Playback: Allows you to adjust the speed of your animation. 

Background Color: Allows you to change the color and style of your background. 

Sent by:    This will automatically insert the name of the registered user and claim the work to be his/hers.

Comment:    This space allows for the entry of any comments by the user.



Background Color

Solid button:    Allows you to use a solid color without gradient.

Horizontal Gradient button:    Allows you to apply two shades horizontally to the @loha work area. 

Vertical Gradient button:    Allows you to apply two shades vertically to the @loha work area. 

Diagonal Gradient A button:    Allows you to apply two shades diagonally from top left to bottom right of the @loha work area. 

Diagonal Gradient B button:    Allows you to apply two shades diagonally from bottom right to top left of the @loha work area.

Rainbow button:    Allow you to apply four shades to the entire work area. 



File Menu
The File Menu lists commands for creating new objects, selecting files, importing graphics, music or sound into 
@loha.



Rules to E-mail By 
Here is a list of    the top ten rules of E-mailing:

1. Introduce yourself by adding your name and web signature to any message that you send to people that you do not know 
personally, or to a large group of subscribers.    Your signature should include your name, position, Internet address, and not 
exceed four lines.

2. No SPAMMING on the Internet.    Please!    SPAM refers to unsolicited electronic junk-mail.    Within the E-mail culture, 
SPAMMERS are not highly regarded, and are often bombarded with retaliatory complaint messages that clog their E-mail 
boxes.      Most E-Mail users do not tolerate the exploitation of the Internet for personal commercial gain.    Try to target your 
messages to people who will appreciate them.

3. Keep in mind that the current Internet culture does not tolerate offensive conduct such as: using abusive language, sending 
Chain letters, or messages that could likely result in the loss of work or systems of the recipient.

4. DO NOT CAPITALIZE WORDS unless you are making an important point, or highlighting a name or title.    Some people might 
interpret a whole message written in capital letters as YELLING!!!!    Upper case is also harder to read than messages written in
lower case.

5. Try not to express an opinion that may be misconstrued as the official position of your employer or any organization to which 
you belong.    You can avoid this by prefacing your opinions with "I believe that…", "It is my opinion that…", or "I feel that…".

6. Sarcasm and satire do not communicate well through E-mail.    Your recipients cannot see the expression of your face, or hear 
the tone of your voice.    It is best to make your mood clear by stating outright that your comments are intended in a joking or 
sarcastic way ("Just joking!"), or use graphics and sound to communicate your mood.    This way, no one will misconstrue your 
attempts at humor.

7. Do not assume that your E-mail messages are private.    Just like print based communication, E-mail leave a paper trail right to 
your door.

8. Be sure to cite all sources, references and quotes to give credit to whom credit is due, and pay attention to all copyright and 
license agreements.

9. Make sure you get permission to forward an individual's personal E-mails to mailing lists or user groups.

10. Above all else, respect your fellow E-mailers.    Always use the kind of language and courtesy you would employ if we were 
speaking to these people in person.    



Step by Step Tutorial - Creating a birthday animation
Let's explore the creativity that @loha brings to your fingertips with this tutorial. 

To create a birthday animation, let's do the following: 
· Select the birthday animation
· Add a personalized message
· Customize the background color
· Add special effects
· Add motion to text
· Add sound or music
· Save birthday card
· Play the birthday card
· Send the greeting by E-mail

Hopefully, at the end of the tutorial, you will end up this card.



Selecting the Birthday Animation
To select the birthday animation, let's do the following:

1. Click and hold on the birthday card animation, cake1, from the character file and drag it to the work area.    The birthday cake 
fills the screen.    Let's adjust the size so that it is smaller:

2. Click on the cake,    handles appear on the four corners.

3. Click on the top left handle and drag it inwards.    The animation decreases in size.    Let's move the animation to the center.

4. Click on the animation and drag it to the center of the work area.    That is its new location.

You are now going to add a personalized message.

Next:
· Add a personalized message
· Customize the background color
· Add special effects
· Add motion to text
· Add sound or music
· Save birthday card
· Play the birthday card
· Send the greeting by E-mail



Adding a Personalized Message
Here we are going to type a simple one line caption, color it and then position it behind the cake.

Step 1: Type a personalized mesasge

Step 2: Change color of text

Step 3: Move and layer text



Typing a personalized message
To add a personalized message, let's do the following:

1. Click on the Text button "A" in the Tools Palette.

2. Click on the work stage.    The Edit Text dialog box displays.    You can use the default font displayed or select another font.    
Let's use another font.    

3. Click on the down arrow next to the font name.    A drop-down selection list appears.

4. Move the selection bar to Arial Narrow and click once.    The name displays in the font bar. Let's adjust the size of the font.

5. Click on the down arrow next to the font size.    A drop-down list selection list appears.    

6. Click once on 72 points.    The new size displays in the size bar. 

7. Click on the Edit Text work area and type MOM.    

Next:

Step 2: Change color of text

Step 3: Move and layer text



Changing the color of the text
Let's change the color of the text from black to dark blue.

1. Click on the Text Color palette button at the top right corner of the Edit Text dialog box.    The Color Palette displays.

2. Select the dark blue color and click on OK.    The color of your greeting changes to dark blue.

3. Click on OK. Your personalized message appears within a text box on the @loha work stage.

4. Click on a text box handle and drag it to fit the entire width of the work stage.    The words "MOM" fill the screen.

Next:

Step 3: Move and layer text



Moving and layering the text
Let's move the cake in front of the word, MOM.

1. Click and hold on the cake to select it and click on the right mouse button.    The Edit Stage dialog box displays.

2. Move the selection bar to Layer and click on the right arrow.    The Layer sub-menu displays.

3. Move the selection bar to the Bring to the Front option and click on it.

The cake moves to the front on the @loha work stage.
You will now customize the background color of the card. 

Next:
· Customize the background color
· Add special effects
· Add motion to text
· Add sound or music
· Save birthday card
· Play the birthday card
· Send the greeting by E-mail



Customizing the Background Color
To customize the background:

1. Click on the Color Fill button.    The Color Palette displays. 
2. Point to anywhere on the work stage and click on the right mouse button.    The Edit Stage dialog box displays. 
3. Click on the Edit Stage option.    The Stage Properties dialog box displays.
4. Select the Background Color tab.    The Background Color dialog box displays.
5. Click on Rainbow.    
6. Click on the top right color button.    The Color Palette displays.    

7. Select orange from the palette and click on OK.

8. Click on the top left color button.    The Color Palette displays.

9. Select yellow from the palette and click on OK.

10. Click on OK.

The new background effect displays on the @loha work stage.    

Background style dialog box.

Next:
· Add special effects
· Add motion to text
· Add sound or music
· Save birthday card
· Play the birthday card
· Send the greeting by E-mail



Adding Special Effects
To add special effects to your graphics and text:

1. Click on the cake to select it.

2. Click on the Effect tab in the @loha gallery.

3. Click on the Grow effect and drag and drop it onto the cake.    The cake decreases in size. 

4. Press the Play button.    The cake increases in size and moves forward.

5. Click on the work stage at anytime to stop the animation.

Now, let's add a motion & sound.

Next:
· Add motion to text
· Add sound or music
· Save birthday card
· Play the birthday card
· Send the greeting by E-mail



Adding Motion to Text
To add motion to text, create the text and then add the effect:

1. Click on the Paragraph tool in the Tool Palette.    Click on the @loha work stage and the Edit Text dialog box displays.

2. Select Arial Narrow from the font box and select size 36 from the font size box.

3. Click on the Edit Text work area and type your name.

4. You can change the color of your greeting or leave it as is.    When you have finished: 

5. Click on OK.    A text box with your greeting displays on the work stage.

6. Drag the text box to center your greeting.    You can now add a special effect to your greeting.    Make sure that your greeting is 
selected.

7. Click on the Effect tab in the @loha gallery.

8. Select the L2R effect and drag and drop it onto your greeting.    

9. Press the Play button to test your effect.

Next:
· Add sound or music
· Save birthday card
· Play the birthday card
· Send the greeting Via E-mail



Adding Sound or Music
To add sound, let's do the following:

1. Click on the Sound tab in the @loha gallery.

2. Select any sound    or music effect and drag and drop it on the work stage.

Next:
· Save birthday card
· Play the birthday card
· Send the greeting by E-mail



Saving the birthday card
1. From the File Menu, click on Save.    The File Save As dialog box appears. 

2. Locate the directory in which you will save the file, for example, C:\@loha\.

3. Type a file name in the File Name box. 

4. Click on OK or press Enter to save the file. 

You are now going to view the animated birthday card.

Next:
· Play the birthday card
· Send the greeting by E-mail



Playing the birthday card
To view the animated birthday card, let's do the following:

1. Click on Play button     at the bottom of the @loha work stage.      

2. Click on the Stop button  to stop the animation.
3. If you want to adjust the speed of the animation, click on the Edit Stage.    The Stage Properties dialog box displays.
4. Click on the Playback option.    The Playback dialog box displays.
5. Adjust the speed by dragging the speed marker to the left or right.      When you have finished, click on OK.

Your first @loha greeting is ready.    If you are satisfied with the animated greeting, let's send it via E-Mail.

Next:
· Send the greeting Via E-mail



Sending the greeting via E-Mail 
Before sending greetings via E-Mail, ensure that you have the address of the recipient and be familiar with how your E-Mail software
works.

To send the greeting:

1. Click on the Send button .    The Confirm dialogue box displays.
2. If this is the first @loha message you are sending to someone, you must include the player @Play with your animation.    
@Play is required for viewing your animation.    Instruct the recipient of your animation to install the @Play.
3. If the recipient has already received @loha messages before then you don't need to send @Play any more.    

4. After this point, your E-mail package takes over.    Please follow the instructions of your E-Mail package on sending 
attachments.

There is also a great section concerning this topic in the Frequently Asked Questions.



Work with Characters
· Select characters from the @loha gallery
· Delete characters
· Move characters on the @loha work stage
· Mirror graphics in the @loha work stage
· Flip characters in the @loha gallery



Select characters from the @loha gallery
To select a character:

1. Select the Character Tab from the @loha gallery.

2. Point to and click on the character you have chosen.    

3. Drag the character to the work stage and release the mouse button.



Delete characters
To delete text, graphics or characters from the @loha work stage:

1. Click on the text, graphic, or character to be deleted.

2. Right click on the mouse button.    The Edit Stage drop down menu displays.

3. Select Delete from the menu or use Delete key.



Move characters on the @loha work stage
To move a character on the @loha work stage:

1. Point to and click on the character.    A marquee with four handles surrounds the character.

2. Drag the character to the desired place on the work stage and release the left mouse button. 



Mirror graphics in the @loha work stage
To make a mirror image of your character on the @loha work stage:

1. Select the graphic by clicking on it      A marquee with four handles surround the graphic.

2. Right click on the mouse.    The Edit Stage dialog box displays.

3. Double-click on the Mirror Left to Right option.

Tip:    Use the mirror effect to change the direction of characters.    For example, a truck can be driving to the left instead of to the 
right.



Flip characters in the @loha gallery
To flip characters on the @loha work stage:

1. Select the character by clicking on it      A marquee with four handles surround the character.

2. Right click on the mouse.    The Edit Stage dialog box displays.

3. Double-click on the Flip Top to Bottom option.

Tip: Use the flip effect to turn characters upside down.    For example,    Santa can be walking on the sky.



Work with Text
· Add a caption
· Add a paragraph of text
· Delete text
· Change font size and style
· Change text color
· Move text on the @loha work stage



Add a caption
To add text without word wrap:

1. Click on the Text tool        in the Tool Palette.
2. Click on the work stage.    The Edit Text dialog box displays.    
3. Click on the Edit Text work area and type your text.    See Add one line of text.

Note:    You can use the default font displayed or select another font.

See also Change font size and style and Change font color. 

The text you write with this function will be one continuous line across your screen.



Add a paragraph of text
To add a paragraph of text with word wrap:

1. Click on the Paragraph tool  in the Tools Palette.
2. Click on the work stage.    The Edit Text dialog box displays.    
3. Click on the Edit Text work area and type your text.    

Note: You can use the default font displayed or select another font. When you write text with this function, it will appear in a 
paragraph format.

See also Change font size and style and Change font color.



Delete text
To delete text, graphics or characters from the @loha work stage:

1. Click on the text, graphic or character to be deleted.

2. Right click on the mouse button.    The Edit Stage drop down menu displays.

3. Select Delete from the menu or use Delete key.



Change font size and style
You can change the font size and style of text from the @loha work stage or the Edit Text dialog box.    

Note:    If you are using the @loha work stage, double-click anywhere on the text.    The Edit Text dialog box displays the text in the 
work area.

Select the text and use the Text bar.

To select font style:

1. Click on the down arrow next to the font name.    A drop-down selection list appears.

2. Move the selection bar to the font you require and click once.    The name displays in the font bar.

To adjust the size of the font:

1. Click on the down arrow next to the font size.    A drop-down list selection list appears. If you already know what font size you 
want, you can type it in.

2. Move the selection bar to the size you require and click. The size displays in the size bar.

3. Click on the bold, italic or underline buttons to add to the text style.



Change text color
1. Use the Edit Text work area to change the color of text.    If you are using the @loha work stage, double-click anywhere on the 

text.    The Edit Text dialog box displays the text in the work area.

2. Click on the Text Color palette button  at the top right corner of the Edit Text dialog box.    The Color Palette displays.
3. Select the color you require and click OK.    The color of the text changes.    
4. If you wish to return to the @loha work stage:

5. Click OK in the Edit Text work area.

6. Use the Fill Bucket to change the color of text:

7. Click on the Color Fill button.  The Color Palette displays.
8. Select a color from the Color Palette and click on OK. 
9. Click on the Bucket Fill tool from the Tool Palette.
10. Click anywhere on the work stage.    
11. The background changes to the color that appears in the Color Fill button.    



Move text on the @loha work stage
To move text on the @loha work stage:

1. Use the selection tool  .
2. Point to and click anywhere on the text.    A text box with four handles surrounds the text.
3. Drag the text box to another point on the work stage and release the left mouse button.    



Work with Backgrounds
· Select backgrounds from the @loha gallery
· Change background color
· Add gradient to a color



Select backgrounds from the @loha gallery
To select a background:

1. Select the Background Tab from the @loha gallery.

2. Point to and click on the background you have chosen.    

3. Drag the background to the work stage and release the mouse button.



Change background color
To change the background color of the @loha work stage:

1. Click on the Color Fill button.  The Color Palette displays.
2. Select a color from the Color Palette and click on OK. 
3. Click on the Bucket Fill tool from the Tool Palette.
4. Click anywhere on the work stage.    
5. The background changes to the color that appears in the Color Fill button.    

See also    Add Color Gradient.



Add color gradient 
To add color gradient to the back ground:

1. Point to anywhere on the work stage and click on the right mouse button.    The Edit Stage dialog box displays. 

2. Click on the Edit Stage option.    The Stage Properties dialog box displays.

3. Select the Background Color tab.    The Background Color dialog box displays with a number of options and four color 
buttons.

Solid button:    Allows you to use a solid color without gradient.

Horizontal Gradient button:    Allows you to apply two shades horizontally to the @loha work area. 

Vertical Gradient button:    Allows you to apply two shades vertically to the @loha work area. 

Diagonal Gradient A button:    Allows you to apply two shades diagonally from top left to bottom right of the @loha work area. 

Diagonal Gradient B button:    Allows you to apply two shades diagonally from bottom right to top left of the @loha work area.

Rainbow button:    Allows you to apply four shades to the entire work area. 



Work with Sound
· Add sound and music
· Remove Sound and Music



Add sound and music 
To add sound and music:

1. Click on the Sound tab in the @loha gallery.

2. Select any sound effect or music file and drag and drop it on the work stage.



Remove Sound and Music
To remove music:

1. Right click anywhere on the @loha gallery.

2. The Edit Stage drop down menu displays.

3. Select Remove Music from the menu. 



Work with Borders
· To add a border
· To edit a border



To add a border
1. Click on the Border Tab in the @loha Gallery.

2. Select a border by clicking on it and dragging it to the work stage.



To edit a border
1. Right click on any border to prompt the Edit Border Menu..    It lists commands for working with borders on the @loha work 

stage.

2. Edit Border:    Allows you to edit or choose the style of your border.    

3. Select borders that entirely frame the work stage, frame just the left and right sides, frame the top and bottom sides, or frame 
just the four corners.

4. Delete:    Allows you to delete borders from the work stage.

5. Layer:    Allows you to layer borders, graphics, text or characters on the work stage.    Displays layer commands such as move 
to back, or bring to front.



Work with Effects
· Add special effects to characters
· Add motion to text
· Remove special effects



Add special effects to characters
To add special effects to characters:

1. Click on the character on the @loha work stage to select it.

2. Click on the Effect tab in the @loha gallery.

3. Click on any effect and drag and drop it onto the character.

4. Press the play button to preview the special effect.

5. Click on the work stage or the stop button at anytime to stop the animation.

See also Add Motion to Text and Remove Special Effects.



Add motion to text
To add motion to text:

· Click anywhere on the text on the @loha work stage to select it.

· Click on the Effect tab in the @loha gallery.

· Click on any effect and drag and drop it onto the text.

· Press the play button to test the effect.

· Click on the work stage at anytime to stop the animation.

See also Add Special Effects to Characters  and Remove Special Effects.



Remove special effects
To remove special effects:

· Press the Undo button or select Undo from the Edit Menu.    This works if you have just applied the effect.    You can also 
remove special effects using the following method: 

· Select by clicking on the character graphic or text in the @loha gallery.

· Right click on the mouse button.    The Edit Stage drop down menu displays.

· Select Remove Effect from the menu. 



Layer the Objects
To layer objects such as graphics or text on the @loha work stage:

1. Select the object by clicking on it.    A marquee with four handles surround the object.

2. Right click on the mouse.    A pop-up menu dialog box displays.

3. Double-click on the Layer option.    The Layer submenu displays with the layering options.    

4. Select one of the options and click on it.

The layering effect is applied to the object on the @loha work stage.



Play the Animation
Use the play bar at the bottom of the @loha work area.

Simply click on the bar to open the panel.

1. Click on Play button     at the bottom of the @loha work stage.      

2. Click on the Stop button  to stop the animation.



Adjust the Play Speed
To adjust the play speed of a graphic or text:

1. Click on the graphic or text.

2. Click on the right mouse button.  The Edit Stage dialog box displays.

3. Click on the Edit Stage.    The Stage Properties dialog box displays.

4. Click on the Playback option.    The Playback dialog box displays.

5. Adjust the speed by dragging the speed marker to the left or right.      When you have finished, click on OK.



Import Graphics, Sound & Music
· To import graphics into the @loha work stage
· Import music into the @loha work stage
· Import sound into the @loha work stage



To import graphics into the @loha work stage
1. Select Import from the File Menu.    The Import submenu displays.

2. Select the Picture option.    The Open dialog box displays.    

3. You can select .bmp, .tif, .jpg or .pcx file formats to import into @loha.    

4. Locate the directory in which the graphic is located.

5. Select the graphic file and double click on it.

6. The graphic file appears on the @loha work stage.



Import music into the @loha work stage
To import music into the @loha work stage:

1. Select Import from the File Menu.    The Import submenu displays.

2. Select the Music option.    The Open dialog box displays.    

3. You can select .mid file formats to import into @loha.    

4. Locate the directory in which the music file is located.

5. Select the music file and double click on it.

6. The music is added to the animation on the @loha work stage.



Import sound into the @loha work stage
To import sound into the @loha work stage:

1. Select Import from the File Menu.    The Import submenu displays.

2. Select the Sound option.    The Open dialog box displays.    

3. You can select .wav file formats to import into @loha.    

4. Locate the directory in which the sound file is located.

5. Select the sound file and double click on it.

The sound is added to the animation on the @loha work stage.



Draw my own objects
· Squares/Rectangle
· Circles/Ellipses
· Freehand objects
· Lines
· Line Width
· Line Color
· Fill Color



Squares/Rectangle
1. Click on the Rectangle Tool from the Tool Palette.          

2. Point to the work stage.    Cross-hairs appear.

3. Drag on the cross-hairs to create the square/rectangle.



Circles/Ellipses
1. Click on the Circle Tool from the Tool Palette.

2. Point to the @loha work stage.    Cross-hairs appear on the work stage. 

3. Drag on the mouse to create the circle/ellipse.



Freehand objects
1. Click on the Freehand drawing tool from the Tool Palette.

2. Click on the work stage and drag the mouse to create a line.

3. Release the button and continue to drag the mouse to create the shape of your object.

4. Double click when finished.



Lines
1. Click on the Line tool from the Tool Palette.

2. Click on the work stage and drag the mouse to create a line.

3. Double click to finish the line.



Line Width
You can easily adjust the thickness of the object outlines and your lines by using the Line Width feature.

1. Simply click on the Line Width button.

2. A drop down menu appears.    Select the choice of width from the menu.



Line Color
To assign colors to your lines and outlines:

1. Click on the Line Color button 

2. Select a color from the Color Palette and click on OK. 

3. Draw your object or line.

4. If the line already exists, click on the Bucket Fill tool from the Tool Palette and drop the color onto the line.

5. Click anywhere on the work stage.    

6. The line changes to the color that appears in the Color Fill button of the Line Color button.    



Fill Color
This versatile tool combined with the Fill Bucket can change colors of almost anything on your @loha work stage. You can use it to 
change colors of text, background, objects and lines.

To change the color:

1. Click on the Color Fill button.    The Color Palette displays.

2. Select a color from the Color Palette and click on OK. 

3. Click on the Bucket Fill tool from the Tool Palette.

4. Click the bucket on the object or line.

5. The object or line changes to the color that appears in the Color Fill button.    



Send the Greeting via E-mail
Before sending greetings via E-Mail, please ensure that you have the address of the recipient and be familiar with how your E-Mail 
software works.

To send the greeting:

1. Click on the Send button .    The Confirm dialogue box displays.
2. If this is the first @loha message you are sending to someone, you must include the player @Play with your animation.    
@Play is required for viewing your animation.    Instruct the recipient of your animation to install the @Play.
3. If the recipient has already received @loha messages before then you don't need to send @Play any more.    

4. After this point, your E-mail package takes over.    The follow are instructional guidelines for the specific e-mail packages:
· AOL
· CompuServe
· Eudora Light
· Eudora Pro
· Microsoft Exchange
· Microsoft Mail
· Netscape
· CC:Mail
· Other E-mail Programs

Please contact your e-mail vendor for details on sending attachments.

There is also a great section concerning this topic in Frequently Asked Questions.    



Receive Greetings via E-mail
@loha messages are received like an attachment.    The following are instructional guidelines for specific e-mail packages.    If your 
e-mail package is not on the list, please contact your e-mail vendor for details on how to receive attachments.

· AOL
· CompuServe
· Eudora Light
· Eudora Pro
· Microsoft Exchange
· Microsoft Mail
· Netscape
· CC:Mail
· Other E-mail Programs



Print My Animation
@loha is a great tool for sending animated @loha-grams to your friends, family and colleagues.    However, don't stop your creativity
there.    Use @loha to its full potential by printing out cards, signs, documents and even presentations.

Just imagine by making ONE @loha-gram, you can actually print out 30 to 40 different clip-arts.    This is the magic of our clip-toon 
concept.    Each animation is made up of many frames and all these frames can be printed.

Print out your graphic projects by:

1. Selecting your favorite frame with the play bar 

2. Click on the Print button or select Print from the File menu.



Printing Ideas for @loha
@loha is a great tool for sending animated @loha-grams to your friends, family and colleagues.    However, don't stop your creativity
there.

You can use @loha to print out:

· Greeting cards

· Special occasion notices

· Announcements

· Invitations

· Certificates

· Color memos and more



Frequently Asked Questions (FAQ)
The following questions are very valuable tips to understanding @loha.    The more you know about @loha, the more you will get out
of this great tool.

Q:    How are @loha-grams (@loha animated messages) actually sent?

A:    Your @loha-gram are sent like an attachment.    Our Send button is designed to make sending e-mail more user friendly for you.
However, some E-mail packages may not fully support this feature.    Therefore, sending an attachment will be a little more 
cumbersome.    You may need to save your animation and then attach the file manually to your E-mail.

Q:    What is @Play?

A:  @Play is a player for your @loha-gram.    Simply include this player, the first time you send your animated messages.    Once 
@Play is received and installed onto the person's PC, you don't need to include @Play with your @loha-grams any more.    

Q:    Why are there 2 different file types for @loha-grams?

A:    The 2 different file types are *.EXE and *.@ha.    If you include @Play with your @loha-gram, you will save it as an *.EXE file.    
In a more technical term, this means that your @loha message is "self-contained".    In another word, your @loha message has 
everything it needs to play on any Windows PC.    However, if the receiver already has installed the @Play in his/her system, 
then you do not have to include @Play again.    The *.@ha file will contain only the animation and has no ability to play on its 
own.

Q:    My E-mail package does not support the Send Mail feature by @loha.    What is the best way for me to attach my @loha
message to the E-mail?

A:  @loha messages are sent as an attachment. E-mail packages are all very different from one another in their technical structure.  
Until there is some type of standard in E-mail packages, sending attachments may be somewhat confusing.    Fortunately, we 
have come up with specific solutions for your E-mail package.    

If your E-mail package is not on the list, please contact the developer of your E-mail tool for instructions on sending attachments.
· AOL
· CompuServe
· Eudora Light
· Eudora Pro
· Microsoft Exchange
· Microsoft Mail
· Netscape
· CC:Mail
· Other E-mail Programs

Q:    How does the receiver see my @loha-gram?

A:    Like any attachment.    In most E-mail packages, he/she just needs to double click on the icon.      However, some packages may
not support this feature.    The receiver simply follow the instructions of his/her E-mail package on "How to receive attachments". 

Fortunately, our technical team has provided detailed instructions for major packages.    
· AOL
· CompuServe
· Eudora Light
· Eudora Pro
· Microsoft Exchange
· Microsoft Mail
· Netscape
· CC:Mail
· Other E-mail Programs

Q:    Can anyone receive my @loha-gram?

A:    Almost anyone.    If they have a Windows E-mail program then they can receive your @loha-gram.    However, there is one 
exception: CompuServe.

CompuServe accounts are able to send attachments to one another smoothly.    However, it has a known problem in its inability 
to send/receive attachments from other E-mail packages.    The attachments become garbled files.



You should contact CompuServe for more information on this issue.

Q:    Does the receiver need Windows 95 to see my @loha-gram?

A:    No.    The @Play that you will include with your @loha-gram can be played on Windows 3.x, Windows NT and Windows 95.    
So, go ahead and send it to everyone you know.

More questions?    Send your questions to support@mediasyn.com

 

Want more Tips?    Sign up for our regular on-line news letter on @loha at news@mediasyn.com



Sending with AOL
To send an @loha-gram using AOL:

1. Save the file in @loha as an *.exe or *.@ha.

2. Start AOL mail.

3. In Mail Menu, select Compose Mail

4. Type in the e-mail address.

5. Click on Attach

6. Select the @loha file and send.

Please contact the E-mail vendor on how to send attachments.



Sending with CompuServe
To send an @loha-gram using CompuServe:

1. Save the file in @loha as an *.exe or *.@ha.

2. Start CompuServe mail.

3. In Mail Menu, select Create/Send Mail.

4. Select the e-mail address and click on Copy.

5. Click on OK to finish address selection.

6. Click on Attach

7. Select the @loha file and make sure the File Type is Binary.

8. Send

Please contact the E-mail vendor on how to send attachments.



Sending with Eudora Light
To send an @loha-gram using Eudora Light:

1. First, follow the instructions to send mail in Send the Greeting via E-mail.

2. Eudora Light will open up with your @loha-gram included in Attachment field.

3. From this point on, simply type in the e-mail address and follow the steps of Eudora Light on sending your E-mail.

Please contact the E-mail vendor on how to send attachments.



Sending with Eudora Pro
To setup Eudora Pro:

1. Select Options in the Tools menu.

2. Select MAPI

3. Under "Use Eudora MAPI server", select Always.

Now you are ready for @loha.    If you do not set up the MAPI option, your @loha will always call up Microsoft Exchange to send 
your E-mail.

To send an @loha-gram using Eudora:

1. First, follow the instructions to send mail in Send the Greeting via E-mail.

2. Eudora    will open up and fill your entire screen.

3. Minimize the Eudora window.

4. The Eudora Address book will appear.

5. From this point on, simply follow the steps of Eudora on selecting an address & sending your E-mail.

Please contact the E-mail vendor on how to send attachments.



Sending with Microsoft Exchange
To send an @loha-gram using Exchange:

1. Click on the Send Mail button (the flying envelop button)

2. The Address book will appear.

3. Select the E-mail address or type in a new one.    Please consult Microsoft Exchange instructions.

4. IMPORTANT: Double click on the E-mail address, the Address Properties dialog box will display.

5. Select the Address Tab. 

6. Deselect "Always send to this recipient in Microsoft Exchange rich-text format".    Click on OK.    If this option is not 
selected, the @loha message may be garble when received.

7. The Send Player Notification dialog box displays.    This feature will suggest to you the best way to send your e-mail.    Please
see Send the Greeting via E-mail for more details.

8. From this point on, simply follow the steps of Eudora on selecting an address & sending your E-mail.

9. Just before you send the mail, you can see the @loha message has been attached to your e-mail as an icon.

Please contact the E-mail vendor on how to send attachments.

To setup Microsoft Exchange:

1. IMPORTANT: Double click on the E-mail address, the Address Properties dialog box will display.

2. Select the Address Tab. 

3. Deselect "Always send to this recipient in Microsoft Exchange rich-text format".    Click on OK.    If this option is not 
selected, the @loha message may be garble when received.

Please make sure that you do not send @loha in rich-text format through the Internet.    However, if you are on a Local Area 
Network, this option does not effect the @loha transmission.



Sending with Microsoft Mail
To send an @loha-gram using Mail:

1. Click on the Send Mail button (the flying envelop button)

2. The Address book will appear.

3. Select the E-mail address or type in a new one.    Please consult Microsoft Exchange instructions.

4. IMPORTANT: Double click on the E-mail address, the Address Properties dialog box will display.

5. Select the Address Tab. 

6. Deselect "Always send to this recipient in Microsoft Exchange rich-text format".    Click on OK.    If this option is not 
selected, the @loha message may be garble when received.

7. The Send Player Notification dialog box displays.    This feature will suggest to you the best way to send your e-mail.    Please
see Send the Greeting via E-mail for more details.

8. From this point on, simply follow the steps of Eudora on selecting an address & sending your E-mail.

9. Just before you send the mail, you can see the @loha message has been attached to your e-mail as an icon.

Please contact the E-mail vendor on how to send attachments.

To setup Microsoft Mail:

1. IMPORTANT: Double click on the E-mail address, the Address Properties dialog box will display.

2. Select the Address Tab. 

3. Deselect "Always send to this recipient in Microsoft Exchange rich-text format".    Click on OK.    If this option is not 
selected, the @loha message may be garble when received.

Please make sure that you do not send @loha in rich-text format through the Internet.    However, if you are on a Local Area 
Network, this option does not effect the @loha transmission.



Sending with Netscape
To send an @loha-gram using Netscape:

1. Save the file in @loha as an *.exe or *.@ha.

2. Start Netscape mail.

3. In File Menu, select New Mail Message.

4. Type the e-mail address in Mail To.

5. Click on Attachment and select Attach File.

6. Select the @loha file and make sure to send As is.

7. Send

Please contact the E-mail vendor on how to send attachments.



Sending with CC:Mail
To send an @loha-gram using cc:Mail:

1. Save the file in @loha as an *.exe or *.@ha.

2. Start cc:Mail.

3. In Message Menu, select New Message.

4. Type the e-mail address.

5. Click on Attach 

6. Select the @loha file in Files and click OK.

7. Send

Please contact the E-mail vendor on how to send attachments.



Sending with Other E-mail Programs
Our technical team has tried to put together as much information as they can on major e-mail packages.    We appologize if your e-
mail package is not included in this list.

@loha sends itself like an attachment.    Therefore, you may need to manually attach the aloha-gram after saving it.    Please contact
your e-mail vendor for specific instructions.



Receiving with AOL
To receive an @loha-gram using AOL:

1. Download the attachment file and save.

2. Double click on the file in its directory and @loha will play.

Please contact the E-mail vendor on how to receive attachments.



Receiving with CompuServe
To receive an @loha-gram using CompuServe:

1. Download the attachment file and save.

2. Double click on the file in its directory and @loha will play.

Please contact the E-mail vendor on how to receive attachments.



Receiving with Eudora Light
To receive an @loha-gram using Eudora Light:

1. High light the file at Attachment converted.

2. Double click on the file in its directory and @loha will play.

Please contact the E-mail vendor on how to receive attachments.



Receiving with Eudora Pro
To receive an @loha-gram using Eudora Pro:

1. High light the file at Attachment converted.

2. Double click on the file in its directory and @loha will play.

Please contact the E-mail vendor on how to receive attachments.



Receiving with Microsoft Exchange
To receive an @loha-gram using Exchange:

1. Double click on the attached @loha icon 
2. @Play will pop open and the animation will begin.

Please contact the E-mail vendor on how to receive attachments.



Receiving with Microsoft Mail
To receive an @loha-gram using Mail:

1. Double click on the attached @loha icon 
2. @Play will pop open and the animation will begin.

Please contact the E-mail vendor on how to receive attachments.



Receiving with Netscape
To receive an @loha-gram using Netscape:

1. Select the attachment icon in the e-mail.

2. Save the file.

3. Double click on the file in its directory and @loha will play.

Please contact the E-mail vendor on how to receive attachments.



Receiving with CC:Mail
To receive an @loha-gram using cc:Mail:

1. Select Save As in the File Menu.

2. Save only the Selected Item

3. Double click on the file in its directory and @loha will play.

Please contact the E-mail vendor on how to receive attachments.



Receiving with Other E-mail Programs
@loha is received like an attachment.    If you are running into problems receiving the @loha-gram, please contact your E-mail 
vendor on how to receive attachments.

Our technical team has tried to put together as much information as they can on major e-mail packages.    We appologize if your e-
mail package is not included in this list.
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